Creating Accessible Forms in Microsoft Word

Introduction

With the instructions below, you can develop easy-to-use forms in Microsoft® Word 2003 or 2007. The Add-Help Text that appears on the status bar each time focus moves into a field makes these forms readily accessible by a person who is blind or who has low vision using JAWS® screen reading software or MAGic® screen magnification software. Help Key (F1) help can be used to give additional instructions.

Set-up

Word 2003 Set-up

To create a form in Word 2003, you use the Forms toolbar. Since this is not among the standard toolbars visible when Word starts, you need to open the Forms toolbar. Here's how:

1. Press ALT+V to open the View menu on the menu bar. 

2. Press T to open the Toolbars submenu. 

3. Next, press DOWN ARROW to select Forms. 

4. Finally, press ENTER to check it. The menus close, and the Forms toolbar appears. 

Word 2007 Set-up

If the Developer tab is not showing on the ribbon, this needs to be turned on. It is normally not on by default. Here's how:

1. Press ALT+F to open the Office button menu. 

2. Press I for Options. The Options dialog box opens with focus on the Popular tab. 

3. Press ALT+D to check the check box "Show Developer Tab in the Ribbon," which is NOT checked by default. 

4. Press ENTER to activate the OK button. The dialog box closes, and the changes are saved. 

Laying Out the Form Content

A form may have extra text that is not directly related to entering data. This may include instructions on how to fill out the form, headings, disclaimers, etc. If you have a lot of text or instructions you might want to consider creating an accessible HTML form instead of a Word form. Text and instructions outside of form controls can be more easily read in an HTML form than in a Word form. Alternatively, consider putting instructions in a separate document to be sent along with the form.

Aside from putting text in a separate document, there are two methods of putting text outside of the Word form controls. Both methods require the end user to have some knowledge of how to navigate the form, and this varies with each method. The two methods are discussed below.

Instructions Embedded within the Protected Area of the Form

This is perhaps the most common type of "accessible" form. In this type of form, the entire document is protected. The user can only move the blinking PC cursor from one control or edit box to another. The PC cursor cannot access the text that is considered instructional, or for which is there for layout of the form, such as headings. That is by design, to keep anything in the form from being modified. The only area where an input cursor is permitted is in edit boxes or other controls. Users normally navigate from field to field by pressing TAB or SHIFT+TAB.

In order to read text that is outside of controls, since there is no blinking document cursor allowed there, the end user must have the ability, and the knowledge to use other methods to read that text. Also, if the end user cannot visually see the text, or move to the text with the normal PC cursor, she may not even know it exists, so the author of the form should somehow make that clear. How might a screen reader user access this sort of text?

The primary method is to use another cursor, such as the JAWS cursor or invisible cursor. The JAWS cursor is the mouse pointer. While it cannot be used to enter text, it can be manipulated around the screen to read text. However, not all screen reader users are comfortable using other cursors. It does take some extra training and definitely more keystrokes to be able to effectively use a secondary cursor to attempt to read the screen. Also, the JAWS cursor only reads text in the visible window, so any text above or below the fold of the screen cannot be read until that part of the screen is actually within the visible window. This means that the end user must constantly switch back and forth between two cursors to be sure to get all of the information. For example, one might first read the screen with the JAWS cursor, then switch to the PC cursor to fill in the fields they heard. After those fields are completed the end user would perhaps press TAB to go to the next field just below the screen fold. Then he must switch back to the JAWS cursor to read "around" the field to see if there is any text there.

Instructions in Separate Non-protected Sections of the Form

An alternative that has been used by some is to put instructional or layout material outside of the areas where the form fields are. The use of the Microsoft Word Sections feature allows the input areas to be protected and keeps the instructional or layout text unprotected. The disadvantage of this is, of course, that new text can be unintentionally (or intentionally) inserted in the sections that are unprotected. Instructions put in the unprotected area can accidentally be deleted. Users of this type of form normally navigate by using UP or DOWN ARROW to move through the document. This allows reading of instructional text, and it also allows movement to fields and other controls.

NOTE: If a person begins pressing TAB in a non-protected section what happens? Tab stops are inserted into the text, since it is not protected. You must instruct people to use UP and DOWN ARROW instead of TAB or SHIFT+TAB to fill out forms that use protected and non-protected sections!

Type in or copy/paste all of the text that needs to appear on the printed form, formatting it as appropriate. The edit fields that people move to in order to fill in data are put into the form for you when you use the options on the Forms toolbar. This ensures that users only type in the right places on the form. (The sample text below shows the form content without the edit areas and check boxes.)

NOTE: Choose this link for sample forms provided for both Word 2003 and Word 2007. There is an example of each before adding form controls and help text. There is also an example of each completely finished and protected form. The finished forms use non-protected sections for instructions and protected sections for form controls.

Sample form text - Microsoft Word 2007 and 2003 documents are included.



Contact Information <Heading>



Instructions: All applicants must complete this section.



Full Name: <Edit box>



Street Address: <Edit box>



City: State: Zip: <Edit boxes>



Phone Number: <Edit box>



Personal Information <Heading>


Instructions: All applicants must complete this section.



Date of Birth: <Edit box>



Sex: Male Female <Check boxes>



Housing Information: <Heading>


Semester you plan to attend: <Combo box>



Dormitory resident? Yes No <Check boxes>



Instructions for campus residents only:



All dormitory residents must provide proof of insurance for



personal possessions.



Only fill out this section if you are planning to reside on campus.



Insurance Company Name: <Edit box>



Policy Number: <Edit box>



Planned Career Path <Heading>



Instructions: All applicants must complete this section.



Major: <Edit box>



Minor: <Edit box>



Other: <Edit box>



Edit Boxes for Text Input

An edit box is the space a person filling out the form uses to type in text or a response to a question on the form. Usually, a highlighted area provides a visual marker to show where to fill in this text. It is a rectangular box which sometimes contains a blinking cursor or may have text already inside of it, which when selected can be typed over or deleted.

Edit Boxes in Word 2003

EXERCISE: Create an accessible text edit field in Word 2003.

1. Place the cursor at the beginning of the space where you expect a person to start filling in text. This is usually, but not always, just to the right of the question on the form. Use the CollegeContactInformation-BeforeAddingFields sample form for practice. For the first example, I put the cursor three spaces to the right of the colon after the label "First Name." 

2. Press ALT to move to the menu bar item File. 

3. Press CTRL+TAB until you move to the forms toolbar. JAWS says Edit Box button. 

4. Press ENTER. An edit box appears at the cursor location back in the Word document. Focus moves from the Edit Box button back to the document. (Mouse users point to and click the first button of the forms toolbar.) 

5. Press LEFT ARROW to move the cursor back into the edit field (it is currently at the right edge of the field). 

6. Press the APPLICATIONS Key, the third key to the right of the spacebar on most computers, or choose the Form Field Options button from the Forms toolbar. (JAWS says Properties button when focus moves there.) This opens a context menu with choices that apply to the form control you are working on. Mouse users just right click the edit field to open the context menu. 

7. Choose Properties from the context menu. This opens a dialog box that allows you to change various aspects of the edit box you just created. For example, you can set default text to appear in a field, or you can limit the number of characters users can type in the edit field. In fact, if you do this, it guarantees that users do not type more than you need them to type. For instance, you can limit the edit field for State to two characters so that users can only fill in a two-letter state abbreviation. You can also choose to set the text format to uppercase. 

8. First, move to the Bookmark edit box by pressing ALT+B. It should read Text1. This is not very informative should you be using bookmarks to move to different form controls later. Rename this to the same name as the form field label, using mixed case if necessary. Spaces are not allowed in bookmark names in Word. In this example, I used FullName as the bookmark. 

9. Next, press ALT+T to activate the Add Help Text button (or click on it). This brings up a multipage dialog box that allows you add a meaningful prompt for the person filling out the form. Focus lands on the Status Bar page tab. 

10. Press ALT+T once or press TAB three times to move to the edit area for adding your own text. The text you enter here is visible on the Word status bar, and is also spoken aloud to a person using JAWS when filling out the form. In most cases, simply type in the same question that is printed on the form. So if the form reads Full Name: type Full Name (with minimal punctuation and no quotation marks). In this case, I used the following text: Full name, including middle initial. If the question on the form is very wordy, you can copy and paste that text into the Type Your Own Text edit field to save extra typing. This field, however, is limited to 138 characters. If the question on the form includes abbreviations such as DOB, spell out the abbreviation (for example, date of birth) so that the prompt is meaningful. 

11. To exit the Form Field Help Text dialog box press TAB to move to the OK button, and activate it with SPACEBAR. 

12. To exit the Text Form Field Options dialog box press TAB to move to the OK button, and activate it with the SPACEBAR. Focus is placed back in the form field in the original document. 

NOTE: You cannot test the form until the form is protected. Instructions for protecting the entire document or parts of a document follow later.

Edit Boxes in Word 2007

NOTE: There are several new form controls called "content controls" that are available in Word 2007 for creating form fields. At the present time, screen readers do not appear to work with forms created with the newer controls. Therefore, these instructions show you how to use legacy controls within Word 2007 to create accessible forms.

EXERCISE: Create an accessible text edit field in Word 2007.

1. Place the cursor at the beginning of the space where you expect a person to start filling in text. This is usually, but not always, just to the right of the question on the form. Use the CollegeContactInformation-BeforeAddingFields sample form for practice. For the first example, I put the cursor three spaces to the right of the colon after the label "First Name." 

2. Press ALT followed by L to move to the Developer Tab of the Ribbon. 

3. Choose the Legacy Tools button in the Controls group of the Ribbon. Press the letter N to activate the Legacy Tools button. The focus is on the Edit Box button. You can press RIGHT ARROW to move across the legacy controls that are available for use in Word 2007. They include: 

· Edit Box (E) 

· Check Box (H) 

· Combo Box (C) 

· Frame (F) 

· Show Field Shading (S) 

· Reset Form Fields (R) 

NOTE: When the Legacy Tools grid appears you can press DOWN ARROW to move into a group of ActiveX controls for Word. It is not within the scope of this lesson to discuss ActiveX controls for Word.

4. Make sure the Edit Box button is selected, and press ENTER. An edit box appears at the cursor location back in the Word document. Focus moves from the Edit Box button back to the document. (Mouse users point to and click the first button of the legacy tools grid.) 

5. Press LEFT ARROW to move the cursor back into the edit field (it is currently at the right edge of the field). 

6. Press the APPLICATIONS Key, the third key to the right of the spacebar on most computers. This opens a context menu with choices that apply to the form control you are working on. Mouse users just right click the edit field to open the context menu. 

7. Choose Properties from the context menu. Alternatively, choose the Properties button from the Controls group of the ribbon (ALT followed by L, then L). This opens a dialog box that lets you change various aspects of the edit box you just created. For example, you can set default text to appear in a field, or you can limit the number of characters users can type in the edit field. In fact, if you do this, it guarantees that users do not type more than you need them to type. For instance, you can limit the edit field for State to two characters so that users can only fill in a two-letter state abbreviation. You can also choose to set the text format to uppercase. 

8. First, move to the Bookmark edit box by pressing ALT+B. It should read Text1. This is not very informative should you be using bookmarks to move to different form controls later. Rename this to the same name as the form field label, using mixed case if necessary. Spaces are not allowed in bookmark names in Word. In this example, I used FullName as the bookmark. 

9. Next, press ALT+T to activate the Add Help Text button (or click on it). This brings up a multipage dialog box that allows you add a meaningful prompt for the person filling out the form. Focus lands on the Status Bar page tab. 

10. Press ALT+T once or press TAB three times to move to the edit area for adding your own text. The text you enter here is visible on the Word status bar and is also spoken aloud to a person using JAWS when filling out the form. In most cases, simply type in the same question that is printed on the form. So if the form label reads Full Name colon, type Full name (with minimal punctuation and no quotation marks). In this case, I used the following text: Full name, including middle initial. If the question on the form is very wordy, you can copy and paste that text into the Type Your Own Text edit field to save extra typing. This field, however, is limited to 138 characters. If the question on the form includes abbreviations such as DOB, spell out the abbreviation (for example, date of birth) so that the prompt is meaningful. 

11. To exit the Form Field Help Text dialog box press TAB to move to the OK button, and activate it with SPACEBAR. 

12. To exit the Text Form Field Options dialog box press TAB to move to the OK button, and activate it with the SPACEBAR. Focus is placed back in the form field in the original document. 

NOTE: You cannot test the form until the form is protected. A discussion of protecting the entire document or parts of a document follows later.

Practice with More Edit Boxes

Practice at your leisure with more edit boxes in this form.

EXERCISE: Finish the remaining edit boxes in this form. Some suggested Bookmark names, Status Bar Help text, and other suggestions follow:

	Field Label
	Bookmark (no spaces)​ 
	Status Bar Help
	Help Key (F1) Help
	Other

	Street Address
	StreetAddress
	Street address, including apartment or unit number
	None
	None

	City
	City
	City name
	None
	None

	State
	State
	State, use two letters only
	None
	Maximum length: 2 spaces; Text format: Uppercase

	Zip
	Zip
	Zip or postal code
	None
	None

	Phone Number
	Phone
	Phone number including area code
	None
	Type: number; Number format: 0

	Date of Birth
	DateOfBirth
	Date of birth, Month / Day / four digit year
	None
	Type: date; Date format: M/d/yyyy

	Insurance Company Name
	InsuranceCompany
	Insurance company name
	None
	None

	Policy number
	PolicyNumber
	Policy number for renter's insurance, campus residents only
	None
	None

	Other
	Other
	Other career path
	None
	None


Creating an Accessible Check Box

A check box is a small box to the left or right of a choice. When the check box is checked a checkmark or an X appears in the box. When the item is not checked, the box is empty.

Check Boxes in Word 2003

EXERCISE: Create an accessible check box in Word 2003.

1. Place the cursor where you expect a person filling out the form to place a checkmark. In this exercise, place the cursor three spaces to the right of the label "Male." 

2. Choose the Check Box button on the Forms toolbar. Press ALT to move to the menu bar item File. 

3. Press CTRL+TAB until you move to the forms toolbar. JAWS says Edit Box button. 

4. Press RIGHT ARROW. JAWS says "check box button." 

5. Press ENTER. A check box appears at the cursor location back in the Word document. Focus moves from the Check Box button back to the document. (Mouse users point to and click the second button of the forms toolbar.) 

6. Press LEFT ARROW to move the cursor back to the beginning of the check box (it is currently at the right edge of the check box). 

7. Press the APPLICATIONS Key, the third key to the right of the spacebar on most computers. This opens a context menu with choices that apply to the form control you are working on. Mouse users just right click the check box to open the context menu. 

8. Choose Properties from the context menu. This opens a dialog box that lets you change various aspects of the check box you just created. For example, check box size determined automatically or set to a specific point size, the value of the check box either checked or not checked initially, and so on. 

9. First, move to the Bookmark edit box by pressing ALT+B. It should read Check1. This is not very informative should you be using bookmarks to move to different form controls later. Rename this to the same name as the form field label, using mixed case if necessary. Spaces are not allowed in bookmark names in Word. In this example, I used Male as the bookmark. 

10. Next, press ALT+T to activate the Add Help Text button (or click on it). This brings up a multipage dialog box that allows you add a meaningful prompt for the person filling out the form. Focus lands on the Status Bar page tab. 

11. Press ALT+T once or press TAB three times to move to the edit area for adding your own help text. In this case, I used the following text: Sex male. In some cases, to ensure that the prompt is meaningful, you may need to type a prompt that is not printed on the form. For example, for a question that has corresponding yes and no check boxes, you should type a prompt that is meaningful for each check box. So in this sample form, the prompt for the Sex check boxes should say Sex male or Sex female. This is even more important if the check boxes are simple Yes or No check boxes. The help prompt should include the question for the Yes or No answer. 

12. To exit the Form Field Help Text dialog box press TAB to move to the OK button, and activate it with SPACEBAR. 

13. To exit the Check Box Field Options dialog box press TAB to move to the OK button, and activate it with the SPACEBAR. Focus is placed back in the form field in the original document. 

Check Boxes in Word 2007

EXERCISE: Create an accessible check box in Word 2007.

1. Place the cursor where you expect a person filling out the form to place a checkmark. In this exercise, place the cursor three spaces to the right of the label "Male." 

2. Press ALT followed by L to move to the Developer Tab of the Ribbon. 

3. Choose the Legacy Tools button in the Controls group of the Ribbon. Press the letter N to activate the Legacy Tools button. The focus is on the Edit Box button. Press RIGHT ARROW to move to the Check Box button, and press ENTER to activate it. Alternatively, press H to activate the Check Box button in the Legacy Tools grid. A check box appears at the cursor location back in the Word document. Focus moves from the Check Box button back to the document. (Mouse users point to and click the second button of the grid.) 

4. Press LEFT ARROW to move the cursor back to the beginning of the check box (it is currently at the right edge of the check box). 

5. Press the APPLICATIONS Key, the third key to the right of the spacebar on most computers. This opens a context menu with choices that apply to the form control you are working on. Mouse users just right click the check box to open the context menu. 

6. Choose Properties from the context menu. This opens a dialog box that lets you change various aspects of the check box you just created. For example, check box size determined automatically or set to a specific point size, the value of the check box either checked or not checked initially, and so on. 

7. First, move to the Bookmark edit box by pressing ALT+B. It should read Check1. This is not very informative should you be using bookmarks to move to different form controls later. Rename this to the same name as the form field label, using mixed case if necessary. Spaces are not allowed in bookmark names in Word. In this example, I used Male as the bookmark. 

8. Next, press ALT+T to activate the Add Help Text button (or click on it). This brings up a multipage dialog box that allows you add a meaningful prompt for the person filling out the form. Focus lands on the Status Bar page tab. 

9. Press ALT+T once or press TAB three times to move to the edit area for adding your own help text. In this case, I used the following text: Sex male. In some cases, to ensure that the prompt is meaningful, you may need to type a prompt that is not printed on the form. For example, for a question that has corresponding yes and no check boxes, you should type a prompt that is meaningful for each check box. So in this sample form, the prompt for the Sex check boxes should say Sex male or Sex female. This is even more important if the check boxes are simple Yes or No check boxes. The help prompt should include the question for the Yes or No answer. 

10. To exit the Form Field Help Text dialog box press TAB to move to the OK button, and activate it with SPACEBAR. 

11. To exit the Check Box Field Options dialog box press TAB to move to the OK button, and activate it with the SPACEBAR. Focus is placed back in the form field in the original document. 

Practice with More Check Boxes

EXERCISE: Finish the remaining check boxes in this form. Some suggested Bookmark names, Status Bar Help text, and other suggestions follow:

	Field Label
	Bookmark (no spaces)​ 
	Status Bar Help
	Help Key (F1) Help
	Other

	Female
	Female
	Sex female
	A check box can be checked or unchecked by using the SPACEBAR. This is a toggle keystroke, so pressing it once turns the check mark on, and pressing it again turns the check mark off.
	None

	Yes
	DormYes
	Dormitory resident yes
	A check box can be checked or unchecked by using the SPACEBAR. This is a toggle keystroke, so pressing it once turns the check mark on, and pressing it again turns the check mark off.
	None

	No
	DormNo
	Dormitory resident no
	A check box can be checked or unchecked by using the SPACEBAR. This is a toggle keystroke, so pressing it once turns the check mark on, and pressing it again turns the check mark off.
	None


Creating an Accessible Combo Box (Drop Down Field)

Combo boxes appear as a rectangular edit box with a graphic of a down arrow appearing to the right of the edit box. This arrow indicates more choices are contained within an attached list box. One of the choices can be displayed in the edit box.

Example, for Semester you might have Fall, Spring, Summer, etc.

Combo Boxes in Word 2003

EXERCISE: Create an accessible combo box in Word 2003.

1. From the Word Forms Toolbar choose the Drop-down Form Field item. (JAWS says Combo Box Button.) 

2. An edit box appears at the cursor location back in the Word document. Focus moves from the Edit Box button back to the document. (Mouse users point to and click the third button of the forms toolbar.) 

3. Press LEFT ARROW to move the cursor back into the edit field (it is currently at the right edge of the field). 

4. Press the APPLICATIONS Key, the third key to the right of the spacebar on most computers, or choose the Form Field Options button from the Forms toolbar. (JAWS says Properties button when focus moves there.) This opens a context menu with choices that apply to the form control you are working on. Mouse users just right click the edit field to open the context menu. 

5. Focus moves to an edit field in the Drop Down Form Field Options dialog box. Type in the first value you wish to use in the list (i.e. Fall). 

6. Press ALT+A to activate the Add button. The first item is added to the list, and focus returns to the edit field where you can type in a second value (i.e. Spring). 

7. Continue this process until all of the values you want are added. If needed, you can press TAB to move to the list of values to select a value, and move that item up or down in the list by using the up or down controls that follow the list. The first item in the list becomes the default value later when the form is being used. 

8. Press ALT+T to activate the Add Help Text button. 

9. Press ALT+T to move to the Type Your Own edit field. 

10. In this example, I typed the following: Choose the semester you plan to attend from the list. 

11. To exit the Form Field Help Text dialog box press TAB to move to the OK button, and activate it with SPACEBAR. 

12. Finally, press ALT+B to move to the Bookmark edit box, and type in Semester. 

13. To exit the Drop Down Form Field Options dialog box press TAB to move to the OK button, and activate it with the SPACEBAR. Focus is placed back in the form field in the original document. 

Combo Boxes in Word 2007

EXERCISE: Create an accessible combo box in Word 2007.

1. Place the cursor where you want to place the combo box. In this exercise, place the cursor three spaces to the right of the colon after the label "Semester you plan to attend." 

2. Press ALT followed by L to move to the Developer Tab of the Ribbon. 

3. Choose the Legacy Tools button in the Controls group of the Ribbon. Press the letter N to activate the Legacy Tools button. The focus is on the Edit Box button. Press RIGHT ARROW to move to the Combo Box button, and press ENTER to activate it. Alternatively, press C to activate the Combo Box button in the Legacy Tools grid. An edit box appears at the cursor location back in the Word document. Focus moves from the Combo Box button back to the document. (Mouse users point to and click the third button of the grid.) 

4. Press LEFT ARROW to move the cursor back inside the combo box (it is currently at the right edge of the combo box). 

5. Press the APPLICATIONS Key, the third key to the right of the spacebar on most computers. This opens a context menu with choices that apply to the form control you are working on. Mouse users just right click the edit box to open the context menu. 

6. Choose Properties from the context menu. This opens a dialog box that lets you change various aspects of the combo box you just created. 

7. Focus moves to an edit field in the Drop Down Form Field Options dialog box. Type in the first value you wish to use in the list (i.e. Fall). 

8. Press ALT+A to activate the Add button. The first item is added to the list, and focus returns to the edit field where you can type in a second value (i.e. Spring). 

9. Continue this process until all of the values you want are added. If needed, you can press TAB to move to the list of values to select a value, and move that item up or down in the list by using the up or down controls that follow the list. The first item in the list becomes the default value later when the form is being used. The values used in this example were Fall, Spring, and Summer. 

10. Press ALT+T to activate the Add Help Text button. 

11. Press ALT+T to move to the Type Your Own edit field. 

12. In this example, I typed the following: Choose the semester you plan to attend from the list. 

13. To exit the Form Field Help Text dialog box press TAB to move to the OK button, and activate it with SPACEBAR. 

14. Finally, press ALT+B to move to the Bookmark edit box, and type in Semester. 

15. To exit the Drop Down Form Field Options dialog box press TAB to move to the OK button, and activate it with the SPACEBAR. Focus is placed back in the form field in the original document. 

Practice with More Combo Boxes

EXERCISE: Finish the remaining combo boxes in this form. Some suggested Bookmark names, Status Bar Help text, and other suggestions follow:

	Field Label
	Bookmark (no spaces)​ 
	Status Bar Help
	Help Key (F1) Help
	Other

	Major
	Major
	Choose the subject you plan to major in from the list.
	Press ALT+DOWN ARROW to open a menu of choices. Press UP or DOWN ARROW to move through this list, and press ENTER when you find the correct item.
	None

	Minor
	Minor
	Choose the subject you plan to minor in from the list.
	Press ALT+DOWN ARROW to open a menu of choices. Press UP or DOWN ARROW to move through this list, and press ENTER when you find the correct item.
	None


NOTE: If you have text to the right of the drop-down field, make sure to put at least three blank spaces between the end of the field and the first part of the text following it. This is because a graphic symbol with a down arrow appears to the right of the field when the form is protected and ready to be filled out.

Adding Help Key (F1) Help

For the average user, no extra help should be needed for filling in regular edit boxes. However, some users may not know how to toggle a check mark on or off, or they may not know how to access the various choices in a combo box. For those situations where a little extra help might be needed, add Help Key (F1) help to Word form controls.

When a JAWS user moves to a control they first hear Status Bar help if it is present, followed by the message "has F1 Key help," if it is present. At that point, the JAWS user has the option of pressing F1 to hear the extra help if they need it. The extra help opens in a new dialog box which is closed by pressing ENTER on the OK button after the message has been read. The message dialog box can also be closed by pressing ESC.

When you access the properties of each form control the Field Options dialog box for the control opens. When you choose the Add Help Text button, focus normally lands on the Status Bar help tab page. This is a multipage dialog box. The second page is called the Help Key (F1) page. To move to this page, and type in Help Key (F1) help:

1. Press CTRL+TAB to switch pages in the multipage dialog box. 

2. Press ALT+T or press TAB three times to move to the Type Your Own edit box. 

Some example Help Key (F1) Key help follows for the check boxes and combo boxes in the included sample form.

Check Box Help Key (F1) Help

Sample F1 Help for a check box might read:

A check box can be checked or unchecked by using the SPACEBAR. This is a toggle keystroke, so pressing it once turns the check mark on, and pressing it again turns the check mark off.

Combo Box Help Key (F1) Help

Sample F1 Help for a combo box might read:

Press ALT+DOWN ARROW to open a menu of choices. Press UP or DOWN ARROW to move through this list, and press ENTER when you find the correct item.

Using Sections for Instructions

Using the Sections feature in Microsoft Word allows authors of forms to have form fields in protected sections and instructions or other text in non-protected sections.

NOTE: Users need to be trained to use UP or DOWN ARROW to navigate forms with sections that are not protected instead of TAB or SHIFT+TAB to prevent tab stops from being inserted accidentally in non-protected sections.

NOTE: When choosing breaks, make sure you distinguish between section breaks and page breaks. One of the choices used in the example form includes the use of both a Next Page and a section break combined. You can also choose just a Next Page break without making it a section break. Be sure to select the correct one. It inserts a section break and starts the new section on the next page.

Sections in Word 2003

EXERCISE: Insert sections in Word 2003 documents.

1. Position the PC cursor where you want to insert the break. 

2. Press ALT+I to open the Insert menu. 

3. Press B to select Break in the menu. The Break dialog box opens with several different choices of radio buttons for breaks. The first three choices are for regular breaks and include page, column, and text wrapping breaks. Do NOT choose these. 

4. Press T to select the radio button for a Continuous section break, or press N to select the radio button for a Next Page section break. 

5. Press ENTER to activate the OK button. The break dialog box closes, and the section break is inserted into the document. 

EXERCISE: Follow instructions below and insert section breaks into the practice document. Insert the correct section break type in the following locations:

1. Continuous section break on the blank line above Full Name. 

2. Continuous section break on the blank line above Personal Information. 

3. Continuous section break on the blank line above Date of Birth. 

4. Continuous section break on the blank line above Housing Information. 

5. Continuous section break on the blank line above Semester you plan to attend. 

6. Continuous section break on the blank line above Instructions for campus residents only. 

7. Continuous section break on the blank line above Insurance Company Name. 

8. Next Page section break on the blank line above Planned Career Path. This inserts a section break, and starts the new section on the next page. 

9. Continuous section break on the blank line above Major: Accounting. 

10. Continuous section break on the blank line above Seaside Campus - Form987B 

Sections in Word 2007

EXERCISE: Insert sections in Word 2007 documents.

1. Position the PC cursor where you want to insert the break. 

2. Press ALT followed by P to activate the Page Layout tab of the ribbon. 

3. Press B to activate the Breaks button in the Page Setup group of the ribbon. A menu of choices appears. 

4. Press DOWN ARROW to move through the choices. Alternatively, press O to choose Continuous section break or N to choose Next Page section break. 

EXERCISE: Follow instructions below and insert section breaks into the practice document. Insert the correct section break type in the following locations:

1. Continuous section break on the blank line above Full Name. 

2. Continuous section break on the blank line above Personal Information. 

3. Continuous section break on the blank line above Date of Birth. 

4. Continuous section break on the blank line above Housing Information. 

5. Continuous section break on the blank line above Semester you plan to attend. 

6. Continuous section break on the blank line above Instructions for campus residents only. 

7. Continuous section break on the blank line above Insurance Company Name. 

8. Next Page section break on the blank line above Planned Career Path. This inserts a section break, and starts the new section on the next page. 

9. Continuous section break on the blank line above Major: Accounting. 

10. Continuous section break on the blank line above Seaside Campus - Form987B 

Viewing Section Breaks

Section breaks and page breaks are not visible in Print Layout view.

NOTE: JAWS announces the number of each new section as the cursor enters the new section. If you want to see the section breaks visually and hear the section break itself when the cursor moves onto it, first change to draft view. Here's how:

View Section Breaks in Word 2003

1. Press ALT+V to open the View menu. 

2. Press N to switch to normal view, which shows section breaks visually on the screen. 

3. Press ALT+V, then P to switch back to Print Layout view when finished. 

View Section Breaks in Word 2007

1. Press ALT followed by W to move to the View tab of the ribbon. 

2. Press E to switch to draft view, which shows section breaks visually on the screen. 

3. Press ALT followed by W, then P to switch back to Print Layout view when finished. 

Saving and Protecting the Form

Once the form is finished it should be protected, and then saved.

Protecting Forms in Word 2003

Authors of forms in Word 2003 should turn off the Forms toolbar, and also make sure that the document is in Print Layout view before saving the document so that end users do not need to do this on their own.

EXERCISE: Protect a form in Word 2003.

1. Press ALT+T to open the Tools menu. 

2. Press P to choose Protect Document. The Protect Document task pane opens. Focus is in the task pane. 

3. If necessary, press F6 to move to the task pane. 

4. Press TAB to move to the check box for "Allow only this type of editing in the document," and press SPACEBAR to check it. 

5. Press TAB to move to the next combo box. 

6. Press F to choose "Filling in forms" in the combo box. 

7. Press TAB to move to the Select Sections link, followed by ENTER to activate the link. The Section Protection dialog box appears. 

8. Press UP or DOWN ARROW to move through the list of check boxes. Uncheck sections 1, 3, 5, 7, 9, and 11. These are the sections on this form that have instructions. They will not be protected. 

9. Press ENTER to activate the OK button. The Section Protection dialog box closes. Focus returns to the task pane. 

10. Press TAB to move to "Yes, Start Enforcing" button. 

11. Press SPACEBAR to activate the button. The Start Enforcing Protection password dialog box opens. Focus is in the Enter a New Password field. 

12. Type in a password, and press TAB to move to the next edit box. Enter the password again. 

13. Press TAB to move to the OK button, and activate it with the SPACEBAR. The document is now protected. 

NOTE: If you leave the password fields empty and activate the OK button the form is still protected. However, anyone who knows how can disable the protection.

To disable document protection in Word 2003:

1. Press ALT+T to open the Tools menu. 

2. Press P to choose Unprotect Document. The document is now unprotected. The exception is that if a password is required, that must be correctly typed in first. Focus is in the task pane. Press F6 to move to the document pane. 

NOTE: If you ever need to make changes to the form text itself, you can enable the Forms toolbar, and then toggle the Protect Form button to unprotect the form, and make the changes. When you're finished, toggle the Protect Form button again to turn protection back on, and then close the Forms toolbar.

Protecting Forms in Word 2007

Before saving or protecting a form it is a good practice to return the view to Print Layout if you changed it during the process of creating the form.

EXERCISE: Protect a form in Word 2007.

1. Press ALT followed by R to move to the Review tab. 

2. Press PR to activate the Protect Document button. 

3. Press ENTER to choose Restrict Formatting and Editing. The Restrict Formatting and Editing task pane opens. 

4. Press TAB to move to the check box "Allow only this type of editing in the document," and press SPACEBAR to check it. Press TAB to move to the combo box below that. 

5. Press F to choose "Filling in forms." 

6. Press TAB to move to the Select Sections link, followed by ENTER to activate the link. The Section Protection dialog box appears. 

7. Press UP or DOWN ARROW to move through the list of check boxes. Uncheck sections 1, 3, 5, 7, 9, and 11. These are the sections on this form that have instructions. They will not be protected. 

8. Press ENTER to activate the OK button. The Section Protection dialog box closes. Focus returns to the task pane. 

9. Press TAB to move to "Yes, Start Enforcing" button. 

10. Press SPACEBAR to activate the button. The Start Enforcing Protection password dialog box opens. Focus is in the Enter a New Password field. 

11. Type in a password, and press TAB to move to the next edit box. Enter the password again. 

12. Press TAB to move to the OK button, and activate it with the SPACEBAR. The document is now protected. 

NOTE: If you leave the password fields empty and activate the OK button the form is still protected. However, anyone who knows how can disable the protection.

To disable document protection in Word 2007:

1. Press ALT followed by R to move to the Review tab. 

2. Press PR to activate the Protect Document button. 

3. Press ENTER to choose Restrict Formatting and Editing. The Restrict Formatting and Editing task pane opens with focus on the Stop Protection button. 

4. Press SPACEBAR to activate the Stop Protection button. The document is now unprotected. The exception is that if a password is required, that must be correctly typed in first. Focus is in the task pane. 

5. Press F6 until focus returns to the document pane. 

Filling Out an Accessible Form

Press the TAB key to move forward from one field to another or SHIFT+TAB to move backwards from one field to another. Fill in the form as needed, and save again or print when finished.

NOTE: To move to instructions and other text that is outside of the form protected area, use UP or DOWN ARROW. If the form has sections that are not protected, use the ARROW Keys to navigate the entire form so as not to miss any important information. Using the ARROW Keys instead of the TAB key also prevents tab stops from accidentally being inserted into non protected areas.

Navigating Forms with JAWS

There are a couple of different ways to navigate a form using JAWS.

List of Form Controls

The list of form controls in JAWS allows you to move directly to a given form control. It also allows you to review form controls and their contents after it has been filled out. The keystroke for the JAWS list of form controls is INSERT+F5.

Navigation Quick Keys for Word (Including Sections)

JAWS has Navigation Quick Keys for Microsoft Word that provide you with an easy and efficient way to move through a document. Quickly move the insertion point to a number of different page elements, including headings, footnotes, endnotes, comments, tables, form fields, pages, sections, and more, with simple keystrokes. This feature is similar to the Navigation Quick Keys JAWS uses in Internet Explorer®, but is especially designed to help you navigate Word documents.

Navigation Quick Keys are automatically enabled while you are reading with the SayAll command. If you want to use this feature when not performing the SayAll command, press INSERT+Z. Then, use the keystrokes to move the insertion point to the next or previous page element of the given type. To turn off Navigation Quick Keys, press INSERT+Z again. JAWS also turns off Navigation Quick Keys if you switch to another document or program.

NOTE: While Navigation Quick Keys are enabled you cannot type text into the document.

Some of the JAWS navigation quick keys that can be used for navigating forms include:

· Bookmark, B 

· Form control, F 

· Heading, H 

· Paragraph, P 

· Section, S 

· Next page, SPACEBAR 

· Prior page, BACKSPACE 

Bookmarks

Bookmarks are a great way to move directly to specific form controls or areas of instructions within a semi-protected form. This is also a GREAT benefit for people who are not screen reader users. For example, a user of a screen magnification program might find using bookmarks to be a handy way to navigate the form. For that matter ALL people, whether using assistive technology or not, can benefit from the use of bookmarks in navigation.

To navigate with bookmarks in Word:

1. Press CTRL+G to open the Find and Replace dialog box. 

2. Press SHIFT+TAB to move to the Go To What list. 

3. Choose Bookmark in the list. 

4. Press TAB to move to the Enter Bookmark Name combo box. 

5. Press ARROW Keys or use first letter navigation to move to the bookmark of your choice, and press ENTER to move there. 
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